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Requirements 
Windows 

• Microsoft Windows 7, Windows Vista, Windows XP 
Home/Professional/Tablet PC Edition, or Windows 2000 

• Intel Celeron/Pentium, AMD K6/Duron/Athlon, or compatible processor 
(800MHz recommended) 

• 512 megabytes (MB) of RAM for Windows 2000/XP, 1 GB for Windows 
Vista/7 

• 30 MB of available hard disk space 
• 1024x768 monitor resolution 
• Internet or phone connection required for product activation 

Mac OS X 
• Mac OS X version 10.4 (Tiger) or later 
• PowerPC G4/G5, or Intel Core Duo processor 
• 512 megabytes (MB) of RAM 
• 40 MB of available hard-disk space 
• 1024x768 monitor resolution 
• Internet or phone connection required for product activation 
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Support 

You can email us at support@phoenixcpm.com with any problems or questions you may 
have regarding Phoenix Project Manager. 
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Using Phoenix Project Manager 
Phoenix Project Manager has two main views to create or edit your schedules: Barchart, and 
Network Diagram. You may already be familiar with the Barchart (or Gantt Chart) view from 
other popular project management software that lays out one activity for every line giving 
details of all activities in a table on the left side. On the right, Barchart shows the flow of the 
schedule with relationships on a timeline. The Network Diagram view, exclusive to Phoenix 
Project Manager, introduces a new way to create schedules influenced by the Arrow 
Diagram Method (ADM). You can create or edit your schedules in both views, however, you 
will only be able to assign network line numbers in the Network Diagram view. 
Tip: You can quickly switch between Barchart and Network Diagram views by pressing 
Ctrl+B for Barchart and Ctrl+D for Network Diagram. 
Both views make use of a timescale at the top of the screen. Changing the scale of the 
timescale is as easy as clicking and dragging anywhere in the timescale. Dragging to the left 
side of the timescale will shrink the timescale while dragging to the right will enlarge it. You 
can customize the look and units shown from the Timescale Format window found from 
the Format menu. You can also access the Format Timescale Dialog by double-clicking or 
right-clicking anywhere in the timescale. 
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Network Diagram 
While in this view, activities can 
be assigned to the same 
horizontal line as other activities 
allowing you to create an easier 
to read, smaller, condensed 
overall view of the schedule at 
the cost of less detail. 
Relationships in this view have 
been optimized to avoid conflicts 
and hidden relationships (with 
exception to activities that share nodes in effect showing an implied relationship). Network 
Diagram also has the ability to group activities by activity code. 

Any new project you create will start you out in the Network Diagram view. We recommend 
you use this view to create all your initial activities using the Draw Activity tool from 
the toolbar (while adding descriptions), setup your activity codes from the Code Library, 
assign your codes to your activities using the Activity Code Editor, then switch over to 
Barchart view to fine tune durations and other activity details. 
Network Diagram View Modes 

There are four modes of operation while in Network Diagram view: Edit , Draw 

Activity , Draw Text , and Draw Image . Switching between these modes from 
the toolbar changes what actions are taken while using the mouse. 

 Edit Mode 

This is the default mode that is used for most operations including selecting activities, 
moving activities to different line numbers, changing activity dates, creating relationships, 
or editing activity descriptions and durations. 

Just like Barchart view, you can click and drag the start or finish node of any activity to 
change its date. If you drag up or down off of the network line that activity is assigned to, 
Phoenix will switch into relate mode allowing you to create relationships between that 
activity and another one on another network line. Holding down Shift while dragging will 
prevent jumping into relate mode when you drag outside of the network line the activity is 
assigned to making it easier to change that activity's start or finish. Holding down Ctrl will 
do the opposite and force relate mode in case you want to create a relationship to another 
activity on the same network line. If you want to create a relationship to an activity that's 
not in view, you can either drag outside of the window to force the window to scroll to that 
activity, or just release the mouse anywhere in the window (except on another activity's 
start or finish) and the manual relationship assignment window will prompt for an activity to 
relate to from a list. 
Selecting activities can be done by either dragging a selection box around the activities you 
want to select (make sure to capture the entire activity from start to finish within the box to 
select it), or you can hold down Ctrl while clicking a single activity to add it to your current 
selection. Holding down Ctrl while dragging a selection box will add any activities in the box 



to your current selection if they weren't previously in the selection, and deselect any 
activities that had already been selected. 

While you can click and drag the duration bar of any activity up or down to change its 
assigned network line, you also have the ability to drag multiple activities at the same time 
as well. Simply select the group of activities you want to move, and drag the duration bar of 
any selected activity to move them all at once. The "ghosted" activities will show what lines 
the selected activities will be assigned to while your dragging. If you drag the selection from 
the bottom activity up to the first network line, all activities will be collapsed onto the first 
line. If you have activity codes assigned and shown, you can click and drag any activity 
code heading text to move all activities in that activity code to a different line without 
selecting them all first. 

Tip: Network line assignments are saved off in your current layout. Create your main 
overall layout including all activities first, save your layout, then copy that layout to avoid 
extra work assigning network lines.  
Even without the Activity Editor shown, you can still edit activity descriptions by double-
clicking just above the duration bar on any activity in between the start and finish nodes 
(where the current description is shown if there is one). Your mouse cursor will change to a 
pointer with a "T" next to it to indicate where you can double-click to edit. You can do the 
same with activity durations shown just under the duration bar. 

 Draw Activity Mode 

As the name might suggest, this mode gives you the ability to draw activities anywhere in 
the Network Diagram. The start date of your new activity will be where you first start 
dragging the mouse with the left mouse button, and the finish date will be where you let go 
of the left mouse button. If you start dragging from the finish or start of another activity, a 
new relationship will be created to the start of your new activity from the start or finish of 
that activity, respectively. Clicking without dragging creates a new zero duration Start 
Milestone activity. 

 Draw Text Mode 

This mode lets you add text labels anywhere in the Network Diagram. They can be used for 
anything, but mostly come in handy if you don't want all of the labels in a specific activity 
code to show, or want them in a different position (in which case you can just turn off that 
activity code, and manually add text labels). Clicking anywhere in the Network Diagram will 
create a new text label tied to the date and network line you click closest to and pop up a 
text editor window that lets you change the text and font. You can select any existing text 
label by clicking on it while in Draw Text mode to edit or delete it. When editing multiple 
text labels, it may come in handy to click and drag the text editor window's title bar to dock 
it on any side of the main window. 

 Draw Image Mode 

Selecting this mode allows you to import any graphics you desire into your Network 
Diagram. Once an image is imported, you can resize the image using the sizers on each 
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corner of it as well as move it to a desired location in the Network Diagram by simply 
clicking and dragging the image. When this mode is selected you can also adjust the size or 
position of other imported images by first clicking on the image to select it and then 
adjusting it as desired. 

Lines 

The optimal lines for activities to appear on can be chosen automatically so in order to have 
a clean Network Diagram it's recommended that you manually move activities to where they 
fit in best with the schedule as a whole. Phoenix provides a couple tools to assist you with 
this process. 

The quickest way to get your Network Diagram in order relies on your schedule already 
having activity codes applied to your schedule to give it an overall organization. First you'll 
want to make sure your organization settings are set the way you want your activities 
organized by opening up the Organization Format window from the Format Menu and 
ordering the codes according to the levels you want to organize by first. With no activities 
selected right-click anywhere in the Network Diagram and select "Group by Activity 
Codes". This will attempt group the activities together by their code hierarchy and compact 
them to as few lines as possible. If you have activities selected the "Group Selected by 
Activity Codes" option will perform this operation on a subset of activities if you don't 
want to reorganize the entire schedule. 
After that is done, you can go into finer detail on each group of activities re-arranging them. 
A good Network Diagram layout will collapse activities in a single relationship chain to save 
space and show that those activities all depend on the activities before them. In some 
cases, collapsing all activities on the critical path can make it easier to see how the critical 
path can affect the rest of the schedule and may point out areas where the schedule can be 
improved. When you find groups of activities that can be collapsed, rather than dragging 
each activity to the same line, you can select all of the activities you want to collapse, right-
click, and select "Collapse Network Lines". This will move the selected activities to the 
first line you have a selected activity on. You can then drag the selected activities to 
another line all at once. 
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Barchart 
This view 
gives you a 
much more 
detailed 
view of the 
schedule 
than 
Network 
Diagram 
when you 
need to 
perform 
mass edits 
on groups 
of activities, or update the schedule. It is also the only view that you can setup Comparisons 
in. The left side of the screen shows the Activity List which lists every activity (that isn't 
filtered) and its details in a table. You can configure the Activity List to show just about any 
detail of every activity as well as how it organizes them by activity codes. The right side of 
the screen contains all of the activities from the Activity List shown on a timescale optionally 
showing their relationships with other (non-filtered) activities. 
Using the Activity List 
The Activity List has the ability to do more than just display activity information in a table, it 
makes editing details of multiple activities easier through the use of Fill Cell and integration 
with the Activity Editor. It also has all the same activity selection capabilities as Barchart 
and Network Diagram views. 

Anytime you have activities selected while in Barchart view, you always have one "focused" 
activity in your selection (in the case of only one activity selected, the selected activity is 
the focused activity). The focused activity is usually (but not always) the first activity you 
selected from the group. You can determine which activity is the focused activity by looking 
for the activity with thicker double border around one of the cells in the Activity List of that 
activity. In the example below, activity 1030 (Install Electrical Conduit) is the focused 
activity. The cell with the double border (original duration in the example) is the focused 
cell. 

Clicking and dragging from 
one activity to another in 
the Activity List selects all 
the activities between 
those two activities. The 
activity you started 
dragging from will become 
the focused activity while 
the last cell you dragged to 
becomes the focused cell of 

the focused activity. If you have at least one activity selected, holding down Shift while 



clicking another activity in the Activity List (or the main Barchart window for that matter) 
will select all activities between that activity and the focused activity and deselect any 
previously selected activities not in between those two activities. Holding down Ctrl while 
clicking on an activity will add that activity to the selection or deselect it if it was already in 
the selection. While selecting activities with Ctrl, new activities added to the selection will 
become the new focused activity, and the cell clicked on to select that activity will become 
the new focused cell. 
The focused cell is important for Fill Cell functionality when you have more than one 
activity selected. Fill Cell comes in handy when you need to change details of multiple 
activities to the same value (or close to the same value). Fill Cell takes the value of the 
focused cell and sets all selected activities to the same value. This works with activity 
durations, descriptions, type, and others. Fill Cell can be accomplished by selecting it from 
the Edit menu, hitting Ctrl+E, or by right-clicking anywhere in the Activity List, and 
selecting Fill Cell. In the example above, hitting Fill Cell would change activities 1040 and 
1050 to both have an original duration of five. 
When only one activity selected, the focused cell is used for integration with the Activity 
Editor. When you select an activity in the Activity List, you can use the up, down, left, and 
right keys to change the focused activity and cell. Hitting left or right changes the focused 
cell to the column on the left or right. Hitting up or down selects the activity above or below 
the currently selected activity. When the focused cell is on a column that supports it, 
anything you type will replace the current value of the focused cell after hitting enter. Once 
you hit enter, the next activity down is automatically selected next and you can repeat the 
same steps to change its values. This means that after you've added new activities to the 
project, you can easily fill in all of their descriptions or durations by selecting the top activity 
by clicking on the cell you want to edit, type out its value, hit enter, type out the next 
activity's new value, hit enter, and so on making for quick data entry. If you have the 
Activity Editor open, and the columns you are changing are shown in the Activity Editor, 
you'll see the values change as you change them. You will still be able to change the values 
even if the controls in the Activity Editor are not shown. 
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Menu Overview 
File 

 

Ctrl+N New 
Pulls up the New Project Dialog for starting a new project. This will not close any projects 
you currently have open. 

 

Ctrl+O Open Opens any existing Phoenix Project Manager project. 

  
Close Closes the active project. 

 

 

Ctrl+S Save 

Saves the active open project. This is only available if you've chosen a file to save your 
project to (using "Save As..." in the File menu), or previously opened the project from a 
saved file and you've made changes to the project. 

  
Save As 

Saves your open project as a new file (or overwrites an existing file under a different 
name). 

 

 

Save As 
PDF 

Prints your open project to a PDF document. This will print the Barchart if you are in 
Barchart view, and the Network Diagram if you are in Network Diagram view. 

 

 

 

Project 
Info Edit your general project information. 

 

  

Page 
Setup Setup printer, page size, margins, and orientation. 

  

Print 
Preview Preview the project printout with your current printer and page layout settings. 

  

Page 
Layout 

Setup page layout settings such as date ranges, horizontal page count, and footer 
information. 

 

Ctrl+P Print 
Prints your project using your current Page Layout settings. This will print the Barchart if 
you are in Barchart view, and the Network Diagram if you are in Network Diagram view. 

 

  
Exit Quit Phoenix Project Manager. 

Edit 

 
Ctrl+Z Undo 

Reverts the last change you made to the schedule. This will not undo changes to 
the layout or view options except network line assignments. 

 
Ctrl+Y Redo Repeats the last change that was reverted. 

 

 

Ctrl+X Cut Copies all selected activities to the clipboard, then deletes them from the project. 
 

Ctrl+C Copy Copies all selected activities to the clipboard. 

 

Ctrl+V Paste 
Copies all activities on the clipboard to the project. This will pull up the Paste 
Dialog with options for activity Id renaming and other copy options. 

 
Delete Delete Deletes all currently selected activities. 

 

 
Ctrl+A Select All Selects all activities in the project. 

 
Ctrl+I 

Invert 
Selection Selects all activities not selected, and deselects all selected activities. 

 

 

Ctrl+E Fill Cell 

Takes the focused Activity List column value for the focused activity, and sets 
all other selected activities to the same value. This only works with certain 
columns such as description, duration, dates, and budget amounts. 

 

Ctrl+Shift+F Find Activity Looks for activities by Id, description, or specific start or finish dates. 

 

Ctrl+F 
Find & 
Replace 

Looks for words you want to change in all activity descriptions and replaces 
them. 

 

  
Link Creates Finish to Start relationships between all selected activities in the order 



Selection they appear in Barchart view. 

  

Unlink 
Selection Deletes relationships between all selected activities that match the given type. 

 

 
Ctrl+Shift+C 

Collapse 
Network 
Lines 

Assigns all selected activities to the first selected activity's network line number 
putting all selected activities on the same network line. 

View 

  
Manage Layouts All layouts can be managed from this menu 

 

 
Ctrl+B Barchart Switches to Barchart view. 

 
Ctrl+D Network Diagram Switches to Network Diagram view. 

 

The following toggle their respective Dockable Tool Window on and off. 
 

F3 Activity Codes  
 

F4 Activity Editor  
 

F5 Predecessors  
 

F6 Successors  
 

F8 Task Notes  
 

 
Resource Assignments Editor  

 

Ctrl+G Resource Utilization Graph  
 

 
Ctrl+T Toggle Relationships 

Hides or shows relationships in Barchart and Network Diagram 
views. 

  

Toggle Non-driving 
Relationships 

Hides or shows non-driving relationships in Barchart and Network 
Diagram views. 

Insert 

 
Ctrl+R 

Related 
Activity 

Adds an activity related finish to start with the selected activity. This also assigns the 
same activity codes to the new activity that are assigned to the selected one. 

 
Ctrl+U 

Unrelated 
Activity 

Adds a non-related activity to the schedule. If there is an activity selected with assigned 
activity codes, the new activity will be assigned to those same codes. 

  
Text Switches to Draw Text Mode when in Network Diagram view. 

  
Image Switches to Draw Image Mode when in Network Diagram view. 

Format 

  

Activity Editor 
Options Change visible Activity Editor options and manage profiles.  

 

  
Timescale Configure timescale tiers, fonts, and colors.  

  
Columns Manage viewable columns in the Activity List.  

  
Bars Change the way activities are drawn in Barchart view.  

  
Sightlines 

Turn year, month, week, or daily sightlines on as well as change the way nonwork 
calendar days are shown.  

  
Organization 

Change fonts and colors of activity codes and the order in which they are organized in 
both Barchart and Network Diagram views.  

  
Rows Change the size of rows in Barchart view. 

  
Dates Change the format that all dates are shown in.  

  
Critical 

Change what is shown as critical, the color, and the threshold at which activities are 
considered critical.  
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Tools 

 

 
Spell Checker Correct spelling mistakes in all activity descriptions.  

 

 

 
Run CPM Checker Identify possible flaws in the schedule.  

  

CPM Checker 
Settings Change the parameters used when running the CPM Checker. 

  
Stop CPM Checker Stop the interactive CPM Checker. 

  

Review CPM 
Exceptions Edit or delete existing CPM exceptions. 

 

 

 
Filters 

Setup criteria based on activity details under which activities are shown in the current 
layout.  

  
Import 

Import a schedule from another format such as MPX, Microsoft® Project XML, 
Primavera P3 and CSV.  

  
Export 

Export schedule data to another format such as MPX, Microsoft® Project XML, and 
CSV.  

  
Reports Print out reports on various details of the schedule.  

Schedule 

  
Sort Setup Barchart view to sort activities by Id, description, start or finish dates. 

 

  
Begin Update Switches into update mode optionally saving off a storepoint. 

  
End Update Finalizes the current update changing the data date to the new proposed data date. 

  
Cancel Update Reverts any changes made during the current update. 

  

Update on 
Schedule Marks all early dates in the schedule up to a given date as actual or estimated dates. 

 

 
F2 Schedule Now Schedules the project using the scheduling method specified in your Scheduling Options. 

  
Auto Scheduling 

Turn auto scheduling on or off. While on, Phoenix will automatically reschedule 
everytime you make a change to an activity. 

 

  

Scheduling 
Options Change the current scheduling method and other scheduling options. 

 

  

Create 
Storepoint Saves off a new storepoint based on your current storepoint.  

  

Manage 
Storepoint Lets you create, delete, rename, and import storepoints.  

  
Comparisons Setup previous storepoints compared against the current schedule in Barchart view.  

Info 

 

 
Code Library Manage available activity codes and the order of values.  

 

 
Calendars Add or remove holidays and non-work days from the project calendar. 

 

 
Cost Accounts Setup cost accounts to track project allocation and expenses. 

 

 
Resource Library Setup or change resources that can be assigned to activities in your schedule.  

 

 

 

 



Help 

 

F1 Help Contents Pulls up this help. 

  
Check for Updates Opens the Phoenix Project Manager website to check for updates. 

  
Phoenix Website Opens the Phoenix Project Manager website. 

  
About Phoenix Check for your current version of Phoenix and other copyright information. 
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Using the Toolbar 

 
File Tools 

•  New: Pulls up the New Project Dialog for starting a new project. 
This will not close any projects you currently have open. 

•  Open: Opens any existing Phoenix Project Manager project. 
•  Save: Saves the active open project. This is only available if you've 

chosen a file to save your project to (using "Save As..." in the File 
menu), or previously opened the project from a saved file and you've 
made changes to the project. 

•  Print: Prints your project using your current Page Layout settings. 
This will print the Barchart if you are in Barchart view, and the 
Network Diagram if you are in Network Diagram view. 

Edit Tools 
•  Cut: Copies all selected activities to the clipboard, then deletes 

them from the project. 
•  Copy: Copies all selected activities to the clipboard. 
•  Paste: Copies all activities on the clipboard to the project. This will 

pull up the Paste Dialog with options for activity Id renaming and other 
copy options. 

•  Undo: Reverts the last change you made to the schedule. This will 
not undo changes to the layout or view options except network line 
assignments. 

•  Redo: Repeats the last change that was reverted. 
Tool Window Toggle Buttons 
These buttons will toggle any of the Dockable Tool Windows on or off. 

•  Toggle Activity Editor 
•  Toggle Activity Code Editor 
•  Toggle Predecessor Editor 
•  Toggle Successor Editor 
•  Toggle Task Notes Editor 
•  Toggle Resource Assignments Editor 
•  Toggle Resource Utilization Graph 

Network Zoom Tools 
•  Zoom In: Enlarges the Network Diagram view. 
•  Zoom Out: Shrinks the Network Diagram view. 

Other Tools 
•  Spell Check: Checks all activity descriptions for spelling mistakes. 
•  CPM Check: Checks the schedule for compliance with CPM Checker 

rules. 
Network View Modes 
These buttons will switch the Network Diagram view mode. 

•  Edit Mode 
•  Draw Activity Mode 
•  Draw Text Mode 



•  Draw Image Mode 
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Dockable Tool Windows 
Phoenix Project Manager provides you with five main dockable tool windows to edit the 
various details of activities and relationships that you may not be able to change in either 
Network Diagram or Barchart views: 

•  Activity Code Editor (F3) - If you have activity codes setup 
through the Code Library, this window lets you change the assigned 
activity codes of all selected activities. 

•  Activity Editor (F4)- Gives you the ability to change the selected 
activity's details from dates to assigned cost account. This window is 
open by default on new projects and is required to change some 
details of an activity. 

•  Predecessor /  Successor Editor (F5/F6) - These two 
windows show all predecessors and successors of the selected activity 
and let you change relationship types and lag as well as delete 
relationships and create new ones. 

•  Task Notes Editor (F8) - This window will let you attach any 
miscellaneous notes you want to any activity as either reminders or as 
additional activity information you can't save off anywhere else. 

•  Resource Assignments Editor - This window will let you manage 
all resources assigned to an activity. 

•  Resource Utilization Graph (Ctrl+G) - This fixed window shows 
a time interval histogram and line chart showing the utilization of any 
single resource. 

All of these windows can be toggled on or off from the toolbar, through the View menu, or 
by hitting their keyboard shortcut (for those that have one). The Activity Editor and Activity 
Code Editor can only be docked to the top or bottom of the main window, while the others 
can be docked on any side. 
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Activity Code Editor 

 

 
The Activity Code Editor is used to assign activities to groups of activity codes found in 
the Code Library. The Activity Code Editor displays a dropdown box for each activity code. 
Selecting a code value from any of them will assign all selected activities to that value. 
You may also type a new value name directly into the dropdown box and hit the Enter key 
on your keyboard to create a new activity code value instead of having to open the Code 
Library and add values there first. 

The checkboxes toggle the visibility of that activity code so you can quickly show and hide 
the activity code levels as needed. 

  
Back to Contents 

  



Activity Editor 
The Activity Editor is the primary tool for changing the attributes of individual activities, as 
well as providing buttons for creating and deleting activities. It provides access to all 
attributes of an activity except activity codes, notes, resources, and relationships. Any of 
the fields for changing attributes can be shown or hidden in the Activity Editor configuration. 
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Predecessor/Successor Editor 
The Predecessor / 
Successor Editor 
gives you a 
convenient place to 
manage all of the 
relationships that 
are the heart of 
your schedule. 
These windows 

show all predecessors and/or successors of the selected activity, as well as the type of 
relationship, starts and finishes, lags, and whether a relationship is driving the successor of 
that relationship. The lag and relationship type can be edited from this window by double-
clicking the cell you would like to edit, and making the change. Relationships can be deleted 
by selecting the predecessor or successor in the list, and clicking the "Delete" button. The 
"Lag To" button gives you the ability to select a date the successor should start or finish on 
(depending on relationship type), and Phoenix will calculate the amount of lag necessary to 
make the activity land on that date (taking non-work calendar days into account) and save 
it off in the relationship. 
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Task Notes Editor 
The Task Notes Editor allows you to attach a note to any activity. To add a task note, select 
the desired activity, and add your information in the editor text box, then click OK to save 
it. Task notes can only be applied to one activity at a time, so if multiple activities are 
selected, the task notes editor is disabled. 
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Resource Assignments Editor 

 

This window will let you manage all resources assigned to an activity. Resource assignments 
have several attributes you can specify. 

• Resource: The resource name of the resource used in this 
assignment. 

• Allocation: The quantity to allocate to an activity 
• Fixed Attribute: If this is set to Total the value of Allocation is 

divided evenly to each day of work the activity has (with the sum of 
the daily allocation for every day of work the activity has matches the 
value of Allocation). If it is set to Daily the value of Allocation is 
used for each day of work. The sum of each daily allocation is equal 
to Allocation multiplied by the number of work days. 

• Accrue At: When the monetary funds are accrued. This can be at 
the Start of work, End of work, or Prorated to evenly distribute the 
funds required evenly across each day of work. 

To modify the resource assignments of an activity you must first select the activity. From 
there you may add or delete resource assignments. 

• Add: Clicking this will bring up the Add Resource 
Assignment dialog. This allows you to configure the values described 
above for your new resource assignment. A resource may only be 
assigned to an activity once. 

• Delete: Clicking this deletes the selected resource assignment. 
• Modifying: You may make changes to a resource assignment by 

modifying the fields in place. The Fixed Attribute of a resource 
assignment may be changed by toggling the radio button in either 
the Total or Dailycolumn. You may only adjust the allocation in the 
field that is fixed. 

Additions, deletions, and modifications to resource allocations only take effect 
when Apply is clicked. To discard changes to the resource allocations click Cancel. 
For convenience you may access the Resource Library by clicking the button 
labeled Library... to make any changes to Resources themselves. 
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Resource Utilization Graph 

 

This fixed window shows a time interval histogram and line and bar chart showing the 
utilization of any single resource you have selected. The period of time is locked to the 
period show above in the barchart or network diagram window. Scrolling the barchart or 
network diagram window will also scroll the resource utilization graph window. To use, 
simply select the resource you'd like to see in the adjoining resource list and the graph will 
be generated. If the graph visibility is toggled it will be included when the project is printed. 
The visibility of the graph is stored on a per layout basis. 

The graph can be configured by clicking the Configure... button. From there you can 
enable and disable the Allocation Bars (including highlighting Over Allocation and the 
limit line for Maximum Allocation) and the Accumulation Curve. Allocation bars show 
the total allocation for the resource for each day across all activities the resource is assigned 
to. The accumulation curve reflects the total allocations of the resource up to the day you 
are looking at. With this graph you can tell at a glance how much of a resource you've 
allocated up to any point in the project. 
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Creating a New Project 
To create a new project in Phoenix Project Manager, click the File menu in the menu bar, 
and select New, or press Ctrl+N on the keyboard. The New Project dialog will appear 
where you can enter in all required project details. 

 

 

 

• Project Title: The project title is typically the official name of the 
project, or at least the working name. For example, if you were 
creating a schedule to renovate a school, the project might be titled 
"Hometown Elementary School Renovation". 

• Project Description: The project description can be nearly anything, 
and is provided for revision names, comments, project details, or any 
other conceivable use. For example, if creating the preliminary 
schedule for the renovation of a school, the project description might 
be "Hometown Elementary School Prelim. Rev 2a w/Codes." 

• Project Start: The project start date is the earliest date any activity 
can begin. Activities without predecessors will start on this date if no 
other restrictions are in place when scheduled. 

• Calendar: The default calendar provides a basic workday calendar for 
your project. Holidays and other non-work can be added through the 
Calendar Creator after creating the project. 

Clicking OK will create a new project with one initial activity and start you out in 
the Barchart View.   Back to Contents 



Setting up Activity Codes 
The Code Library allows you to define activity codes and values for organizing the activities 
in your schedule. The Code Library window can be accessed by selecting Code Library from 
the Info menu. Activity codes and values are shown in a hierarchical tree. 
Adding Codes and Values 
New activity codes can be 
easily added by clicking the 
Add Code button. You can 
add values by selecting the 
activity code you want to add 
a value to and then clicking 
the Add Value button. To edit 
the name of the newly created 
code or value, select it and 
click the Edit button. 
Managing Activity Codes 
and Values 

There are several ways you 
can change or manage your 
activity codes and values: 

• Edit: This button lets you 
change the name of any 
activity code or value in the list. 

• Delete: You can remove any value or a full activity code along with all of its values by 
clicking this button. 

• Move Up: Moves the selected value up in the list of values for its corresponding 
activity code. 

• Move Down: Moves the selected value down in the list of values for its corresponding 
activity code. 

Importing 
You can import activity codes and values from another project you have done by clicking 
the Import button. Once you have selected the Phoenix project file you want to import 
from, the active storepoint's activity codes and corresponding values will be imported into 
your current project. 
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Setting up Calendars 
Calendars in 
Phoenix 
keep track 
of holidays, 
weekends, 
and other 
periods of 
time in your 
project 
when work 
can't be 
done and 
must be 
delayed. 
The Calend
ar 
Creator can 
be found 
from 
the Info menu. 
Only one calendar can be in use for your entire schedule as Phoenix does not support multi-
calendar projects currently. If you selected the wrong calendar when first creating your 
project, you can either switch to one of the other default calendars by selecting it and 
clicking Set as Calendar, create a new one with the appropriate settings (see below), or 
modify the current calendar's settings. 
The three default calendars included in all new projects are the 5 Day, 6 Day, and 7 
Day calendars. The 5 Day calendar defines Saturdays and Sundays as non-work days by 
default, the 6 Day calendar defines Sundays as non-work days by default, and the 7 
Day calendar doesn't define any non-work days. 
Creating a New Calendar 
You can create a new calendar with no non-work definitions by clicking Add New 
Calendar button and typing in the name of your calendar. 
You can also duplicate an existing calendar by clicking the Clone Calendar button after 
selecting the calendar you wish to clone. 
Setting up Non-Work Days 

Non-work days can be added to any of the calendars including the calendars included by 
default by selecting the calendar you want to add them to, and adding one of the two types 
of non-work days that describes the behavior you want for that non-work day. 

• Single Non-Work Day: This is the most simple of the non-work types you can add to 
a calendar. Just select the day you want to make into a non-work day, and click 
the Set as Non-Work button under the calendar. This will make that single day (of the 
selected month and year) into a non-work day and all activities that overlap that day 
will be pushed to finish one day later. 



• Repeated Non-Work:' This type of non-work type is used when you need a 
specific day off with a set frequency. Select the day you want to make into a 
recurring non-work day, and click the Repeat...button under the calendar. You can 
choose between daily, weekly, monthly, or yearly. This can be used set a yearly holiday 
or non-work days every other week. Set the expiration if you'd like to end the definition 
at a fixed date or after a certain number of occurrences. 
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Filtering Activities 
Filters are a tool for reducing the number of activities displayed in the project without 
deleting them or otherwise removing them. Activities that have been filtered out will still be 
used for all calculations and reports. Filters can be setup by selecting Filters from 
the Tools menu. This window consists of two sections. The lower section shows which filters 
are currently defined for the project, and the upper section shows which filters are currently 
applied. A filter must first be defined before it can be applied to the project. Filters can also 
be imported from another project by clicking the Import button, and selecting the Phoenix 
Project Manager project file. 
Creating a New 
Filter 
Clicking the New 
Filter button in 
the Available 
Filters section of 
the filter window will 
open up the 
Create/Modify 
Filter dialog. Then 
enter a name for the 
new filter and select 
either Matches 
All if you need the 
filter to match all 
criteria specified to 
be considered a match or Matches Any to make the filter consider an activity that matches 
any one of the criteria a match for your new filter. After criteria have been setup for your 
new filter, click OK to save the filter to your Available Filters. 
Setting up Criteria 
While all your criteria can be specified in different filters, it may make more sense to setup 
multiple criteria in a single filter so Filter Actions are more clear when applying multiple 
filters in complex filter situations in large projects. To create criteria for a filter, click 
the Add New button, which will create a single new criterion. Criteria consist of a target 
field, comparison type, and one to two parameters. These attributes must be specified in 
order. 

1. First, select from the following available target fields: 
• Activity ID 
• Description 
• Calendar 
• Original Duration 
• Free Float 
• Total Float 
• Actual Dates 
• Actual Start 
• Actual Finish 
• Early Dates 



• Early Start 
• Early Finish 
• Late Dates 
• Late Start 
• Late Finish 
• Estimated Dates 
• Estimated Start 
• Estimated Finish 
• Any Assigned Activity Codes 
2. Then select the type of comparison you want to make on the target field. These will vary 

based on the selected target field. 
3. Once a comparison type has been selected, one or two parameters will be shown to be used 

with the comparison type on the target field. 
4. Once the parameters have been specified, click Add New to specify additional criteria and 

repeat the process, or OK to add the filter to your list of Available Filters. 
Criteria can be removed from a filter by selecting the row with the criteria, and 
clicking Remove. 
Setting up a Filter Chain 
Once a Filter has been defined, it can be applied to the project by selecting it in the list of 
Available Filters, and clicking the Add To Active Filters button. This will add it to the list of 
Active Filters in the lower section of the filters window. If more than one filter is applied to 
the schedule, the filters can be ordered using the Move Up and Move Down buttons, so 
the filter at the top of the list is applied first, and the remaining filters are applied in 
descending order. 
If multiple filters are applied, there are two options for every filter after the first. The Filter 
From option specifies whether this filter is applied to a list of all activities in the project, or 
just the results of the last filter. The Action option specifies which of the following actions 
the filter will perform: 

• Inclusive: This filter will add its results to the results from the last filter. The first filter 
in a filter chain always uses this behavior. Applying this action to the results filtered 
from the last filter will result in the same list of activities since no activities will be 
matched that aren't already in the resulting list of activities. 

• Exclusive: This filter will remove matching activities from the results of the last filter. 
There is no difference between applying this action to All Activities or Last Filter since it 
can only remove activities that are already in the results from the last filter. 

• Invert: Any activities that match this filter will be removed from the results from the 
last filter, and all other additional activities that match that weren't previously in the 
results from the last filter will be added to the list of remaining activities for the final 
result of this filter. If this action is applied to the results from the last filter, it has the 
same effect as an Exclusive filter, since only activities from the last filter's results will 
be matched in this filter. 

Once all of the filters have been applied in order, a final resulting list of activities is created. 
You must select whether you would like those activities to be shown or hidden. If you 
select Show, the activities will be shown, and all other activities will be hidden. If you 
select Hide, they will be hidden, and all other activities will be shown. To remove a single 
filter from the list of Active Filters, select the filter and click the Delete Filter button. To 
remove all Active Filters, click the Clear Filters button. 
Back to Contents 



Running Reports 
Phoenix comes with numerous predefined reports on most aspects and details of any 
schedule, and may provide additional report templates available for download in the future. 
To print any available reports, open the Reports window by clicking Reports in 
the Tools menu. 
To preview a report just double-click the desired report from the list or select it and click 
the Preview button. When you select a report from the list, a description of the selected 
report is shown on the right. 
If you need to change your printer settings you can do so by clicking the Page 
Setup button at the bottom of the window. If you adjust your printer settings before 
previewing a report, your changes will be reflected in the preview window. 
If "Organize by Activity Codes" is checked, Phoenix will organize all activities the same 
way they are organized in Barchart view with activity code labels. The order in which they 
are organized can be configured from the Organization Format window. 
The Save to File button will run the selected report, but rather than printing it, it will save 
the report to a HTML file suitable for publishing to a website or opening in other applications 
such as a word processor. When the button is pushed, Phoenix will ask you for a location to 
save the file to. 
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Layouts and Formatting 
Phoenix Project Manager allows you to change the look and feel of most of your schedule. 
This is done mostly through the Format window found in the Format menu. Phoenix also has 
the ability to store off all of your current view options and formatting in multiple layouts 
giving you the ability to customize your view for use during specific specific stages of 
working on your schedule, working on different areas of your schedule, and/or for sending 
your schedule to others already laid out how they expect to see the schedule. You can setup 
as many layouts as you want or need and switch between them with ease using the Layout 
Manager. 

All of the following options are saved off individually per layout (and possibly more): 

• All formatting options including: 
• Timescale settings 
• Columns settings 
• Barchart Bar settings 
• Sightlines 
• Organization settings 
• Row settings 
• Dates format settings 
• Critical Path settings 
• The current active view (either Barchart or Network Diagram) 
• Assigned network lines and text labels 
• Any applied filters 
• Barchart comparisons if they are setup 
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Layout Manager 
A Phoenix project can have multiple Layouts which determine how the schedule is 
displayed. There is one Active Layout which is used for the current display of the schedule. 
All formatting options are stored in a layout and you can customize the entire appearance of 
the schedule several times by using multiple layouts. The current active layout is listed in 
the first status bar section from the left. 

 

 

 
Layouts also determine what the active storepoint is and what comparisons are displayed. 
By default a layout is set up to track the newest storepoint. This saves you the trouble of 
having to manually change the active storepoint for every layout when you create a new 
storepoint. If you'd like to lock a layout's active storepoint to a particular storepoint you can 
change that option in the Manage Storepoints window. 
Manage Layouts 

Layout management can be accessed 
from Manage Layouts... in 
the View menu. From here you can 
create, delete, rename, select the active, 
and import layouts. 
Clicking the Create button shows you a 
dialog where you can name and select 
whether to base the new layout off of an 
existing layout or create a new blank 
layout with default format options. 
The Delete button will delete the selected 
layout. This cannot be undone and all 
format data stored in that layout will be 
lost if you save your file so be sure you 
want to do this. If the active layout is 

deleted a new layout is made into the active layout. 
Selecting Rename will begin editing the name of the selected layout. There are no 
restrictions on what you name your storepoint so be as descriptive as you want but the 
name you use must be unique. 
The Make Active button switches the active layout to the selected layout. The schedule's 
appearance will update immediately with the newly active layout's formatting options. 



Import lets you insert layouts from another Phoenix schedule file into this project. This can 
be useful if you have formatting options you want to apply to several projects. 
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Activity Editor Options 
The Activity Editor Options window can be found by selecting Activity Editor Options from 
the Format menu. This window lets you configure which fields are shown in the Activity 
Editor. 

There are two layout configurations you can choose from: 

• Default Editor: The default editor configuration shows all controls and 
is the default for any new project. 

• Update Mode Editor: When starting an update Phoenix will 
automatically switch to the Update Mode configuration. This 
configuration only shows controls that are most useful for updating a 
schedule. 

For each row of the Activity Editor, you will see a list of controls contained in the row. For a 
given configuration you can choose which rows you would like to be visible by selecting the 
checkbox next to it. To hide a row, simply clear the checkbox. 

The Show activity management buttons option allows you to show or hide the Activity 
Editor buttons for creating and deleting activities. 
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Timescale 

 

 
This format window affects how the timescale is displayed in Barchart view, Network 
Diagram view, and all printouts. The timescale is split into multiple tiers (or rows), each 
with the ability to show different units of time. The format window gives you a preview of 
any timescale settings you change in this window on the top so you can see how it will look 
before you apply those changes. The bottom tabs contain all the configurable settings for 
each individual tier. 

Each timescale tier can be turned on or off by toggling the Shown checkbox. Tiers can be 
set to show years, months, weeks, or days by changing the Display setting. 
Tip: If you need to come back to this window to make changes to the timescale often, you 
can quickly access it by double-clicking in the timescale at any time. 
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Columns 
From here you can 
add, remove, re-
order, and change 
the look of the 
Activity List header 
as it looks in both 
the barchart view 
and in any printouts. 
The top window 
gives you a preview 
of the columns, and 
also gives you the 
ability to drag and 
drop columns in a 
different order as 
well as resize any 
column by dragging 
its right border. The 
font and background 
color settings apply 
to the entire Activity 
List header, the 
color can be 
changed by clicking 
the Background 
Color button. 
You can add new 
columns to the Activity List by clicking the Add button and selecting the column type you 
want from the list. If you have a column selected in the Column Configuration list, new 
columns will be added after the selected column, otherwise they will be added at the end. 
By clicking the Edit button you can change a selected column's label and width as it will be 
shown in the Activity List. Any column in the list can be removed by selecting it, and clicking 
Remove. You can also change the order of any selected column by clicking the Move Up 
and Move Down buttons. 
If you only need to change the order of the columns or their sizes, you can do so without 
opening the Format window by dragging the right border of the column in the Activity List 
header itself and dragging and dropping the columns just like you can in the preview 
window. You can also have Phoenix set an automatic column size by double clicking the 
right border of any column in the main Activity List header (not in the preview). Phoenix will 
calculate the smallest size the column can go without cutting off any information and set it 
to that width. 
Tip: Quick changes to the headers can be made by double-clicking on the Activity List 
header at any time to pull up this window. 
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Bars 
The appearance of 
activities in the 
Barchart view is very 
flexible making it 
possible to configure 
different types of 
activities to stand 
out from the rest of 
the schedule and 
make it easier to 
identify them. It is 
also possible to add 
additional activity 
information 
displayed next to the 
activity. Every bar's 
appearance can be 
changed from this 
window including 
each comparison's 
activities if 
comparisons are 
setup. The top 
portion lists all available bar types you can change. Selecting any one of them will show it's 
current settings in the Configure Bar Appearance area. From there, you can click on any 
area of the activity to change it's options. 
Activity information can be added to activities by clicking on any of the outside 8 boxes 
around the activity in in Configure Bar Appearance area. Adding text to any of the left 3 
boxes will result in that text being drawn before the start date of those activities. Adding 
text on the right will result in that text being drawn after the finish date. The center three 
boxes are for configuring the bar and endpoints of any activities. 
Note: Any text added to the top or bottom of any activities will collapse on top of the 
activity if the row size is too small to fit it. Remember to change the row size accordingly 
from the rows configuration page in the format window. 
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Sightlines 
Project sightlines 
can be turned on or 
off by toggling the 
checkbox next to the 
sightline(s) you want 
to turn on or off. 
Below is a brief 
description of what 
each of the 
sightlines settings 
are for: 

• Project 
Start 
Date: Thi
s includes 
both the vertical line marking the project start date, as well as the text 
"Project Start Date" which appears next to it. The color for both is set 
by using the color picker. 

• Data Date: The data date is the date that the schedule should be up-
to-date with from the last update. This setting includes the vertical line 
marking the data date, the text "Data Date" which appears next to it, 
and, when in Update Mode, includes the update net as well that 
spans from the current data date to the new proposed data date for 
that update. Turning the data date off will also turn off display of these 
other features. The color for all three features is set by using the color 
picker. 

• Major/Minor Sightlines: Major and minor sightlines function in the 
same manner. They act as visual guides that mark a particular 
repeating interval of time. If enabled, their appearance can be 
configured by selecting one of the following line 
styles: Solid, Dotted, Short Dash, Long Dash, or Dot Dash. The 
major and minor sightlines can be set to repeat at any of the following 
lengths of time: Days, Weeks, Months, or Years. If, for example, 
you set either of the major or minor sightlines to repeat every three 
months, you will have four sightlines for every year at a quarterly 
interval. 
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Organization 

Every activity code 
in your schedule can 
be organized in a 
different order, and 
every value for each 
activity code can 
shown in a different 
order as well. You 
must have activity 
codes setup in the 
Code Library first 
though before being 
able to change 
anything in this 
window. The values 
can be re-ordered 
from the Code 
Library, while the 
activity code 
ordering is managed here. The activity code ordering in this window determines which codes 
will be organized first, second, and so on. This has a slightly different effect on both 
Barchart and Network Diagram views, but still applies to both. 

In Barchart view, all activities are organized by their assigned values in the first activity 
code listed, then broken down further from there based on the activity code listed second, 
and so on. Values are listed in the same order they appear in the Code Library. In Network 
Diagram view, activities are grouped the same way except boxes are drawn around the top 
activity code values first, and broken down from there. It is possible (and likely) that you 
will see two or more boxes for the same activity code value for codes that aren't listed first 
in this organization window just as you would see multiple sections of the Barchart 
dedicated to the same activity code value, they are just split up on the higher level activity 
codes first. 

Organizing by specific activity codes can be turned off completely by toggling the checkbox 
next to that activity code. Turning off organizing by an activity code will skip that code, and 
move on to the next. Activities assigned to values in an activity code you turn off will not be 
hidden, however, that can be accomplished with Filters. 

Changing the font of activity codes only currently affects the font used for the labels in the 
Network Diagram view while the color will affect the color of the activity code in both 
Barchart and Network Diagram views. 

Network Activity Code Visibility 

These settings control how activity codes are drawn in the Network Diagram view. 



• Labels: If on, activity code value descriptions will appear in the upper left corner of all 
activities assigned to that value (split up in the order they are organized). 

• Outlines: This will toggle drawing outlines around all activities assigned to activity 
code values shown. 

• Background: This fills in a lightly colored background highlighting all activities 
assigned to activity code values shown. 
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Dates 

 

 
All dates shown in your project in Barchart, Network Diagram, the Activity List, printouts, 
reports, and others can be formatted using the date formatting options given here. 

• Date Order: Specifies the order in which the date elements (day, 
month, year) are displayed. If 4-Digit year is checked, years will be 
displayed with 4 digits, (e.g. 1997, 2005). Otherwise, years will be 
displayed with 2 digits (97, 05). 

• Date Separator: Defines the character inserted between the date 
elements. 

• Month Format: Defines whether months will be displayed as a 
number, full name, or three letter abbreviated name. 

The Preview shows an example of how the dates would be displayed if the current options 
were saved. 
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Critical Path 

 

 
The first setting in this window lets you choose whether to use the longest path to 
determine whether an activity is critical or to mark any activity with a total float below the 
specified amount as critical. 

The appearance options allow you to define how the critical path will be shown. By selecting 
the Color button, you can choose the color that will be used for showing critical path 
elements. You can choose which elements of the critical path you would like to have drawn 
in this color by checking or unchecking the checkbox next to an element. 

These are the elements you can choose to have colored when they are part of the critical 
path: 

• Tasks 
• Milestones 
• Endpoints 
• Relationships 

By default, all elements will change color if marked as critical. 
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Importing 
Phoenix is capable of importing projects from other software formats such as Microsoft 
Project and Primavera. To import a project from another format click Tools and choose the 
desired import method from the Import submenu. It is important to note that when you 
import data from other formats there will be information that cannot be imported or 
represented perfectly in Phoenix. 
Primavera 3.1 Projects 

Primavera projects are stored in a database format that requires specific software to be 
installed on your computer. If you own Primavera, simply having it installed on your 
computer should be sufficient. If you do not own Primavera, you can install a third-party 
database engine called Pervasive SQL. 

Project Directory 
To import a Primavera 
project, a directory must 
be selected that contains 
valid Primavera project 
files (named with a file 
extension of .P3). The 
default location 
is C:\P3WIN\PROJECTS. 
You can click the 
Browse button to select 
a different directory if 
you have project files 
located elsewhere. 
Available Projects 
Once you have selected 
a directory 
the Available 
Projects list will show 
you the Primavera 
projects found in the 
selected directory. The 
project name and 
description are shown 
just as in Primavera. Select a project from the list and click the Import button to import it. 
The Schedule immediately when importing has finished option causes the project to 
be scheduled automatically once it has been imported successfully. 
MPX or XML Projects 

To import from MPX or XML projects, browse to the location of the file and click Open. You 
will be presented with an Import Options dialog that shows some information about the 
project file. 



The project title and number of tasks and calendars in the project are shown in the header 
at the top of the Import Options dialog. 
There are two tabs shown in the Import Options dialog: 

• Information: Gives information about the import capability for the chosen file. 
• Tasks: Lists the tasks found in the project file and allows you to choose whether or not 

to import tasks and/or relationships from the project. 
The Immediately schedule after importing option causes the project to be scheduled 
automatically once it has been imported successfully. 
Comma 
Separated 
Values (CSV) 

The CSV importer is 
capable of importing 
activity data and 
relationships that 
have been exported 
from other software 
or from Phoenix 
Project Manager. 

Once you have 
selected a CSV file 
to import data from 
you will be presented with the Import CSVdialog. This dialog allows you to map the fields 
in the CSV file to their appropriate internal data types and select various options relating to 
the data. In the box used for mapping the fields to their types there are two columns: 

• Assigned Type: Lists the supported data fields that can be imported from any given 
CSV file. 

• CSV Field: Each dropdown box contains a list of all fields contained in your CSV file. 
Select the field from this dropdown box that corresponds to the internal type listed in 
the Assigned Type column. 

In the Options box there are several options you can choose from to change the way the 
data is imported: 

• File includes column headers: Most of the time when you export data from other 
software in a CSV format the column headers are included as the first line of the CSV 
file. If this is the case then leave this option checked. If the file contains only raw data, 
you will want to uncheck this option so that importing will begin at the first line of the 
file. 

• Begin at line: Specifies which line of the file the importer should begin at. If the first 
line of the CSV file contains a header you will want importing to begin at the second 
line. 

• Text delimiter: Some CSV files for one reason or another may not be delimited by 
commas. If you are importing from such a file, this allows you to select the character 
used as a delimiter in the file. 

• Schedule immediately after importing: Once importing has completed successfully, 
this will automatically schedule the imported activities. 



The Unit Conversion options allow you to set the default unit settings you have used for 
the data you are importing. This allows the importer to more accurately convert data (eg. 
durations) to the default units used in Phoenix Project Manager. Conversions may not work 
flawlessly so you should verify the data after it has been imported. 

 

XER 

To import from an XER project browse to the location of the file and click Open. The project 
will be imported immediately without prompt. 
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Exporting 
Phoenix is capable of exporting projects to other software formats such as Microsoft Project 
and CSV files. To export data from Phoenix click Tools and choose the desired export 
method from the Export submenu. 
MPX and Microsoft Project XML 

The MPX format was created by Microsoft as a common way to transfer data between 
different scheduling software. The format is somewhat limited, however can be a good way 
to transfer project data between Phoenix and other software such as Microsoft Project. For 
transferring data to and from Microsoft Project, however, the XML format is desired because 
it can contain much more information than the MPX format can and therefore your schedule 
data will be more accurate. 

To export data to either of these formats, select it from the Export submenu. 

You will see 6 tabs that 
allow you to customize 
various detailed export 
options: 

• Tasks: Presents a list of 
tasks in the schedule and 
allows you to choose 
whether you want to 
export tasks, 
relationships, or both. 

• Calendars: Shows the 
available calendars in the 
project and allows you to 
choose which one(s) you 
want to export with the 
rest of the schedule data. 
The base calendar is 
automatically selected 
and cannot be deselected 
unless you uncheck 
theBase Calendar option 
from theProject tab. 

• Project: Lists a number 
of options relating to the 
project as a whole. 

• Defaults: Default 
workday information. 

• Currency: Currency 
information used for the 
schedule. 

• Date/Time: Detailed 



date and time information used in the schedule. 
The Schedule before exporting option causes the project to be scheduled automatically 
before it is exported. 
Comma Separated Values (CSV) 

The CSV format exports a list of all activities and relationships in a simple format that can 
be easier to manipulate. CSV files can be opened directly by Microsoft Excel for editing and 
Microsoft Project allows you to import from CSV files easily. Please note that the CSV format 
only allows you to export activities and information related to each activity. No project 
information is exported. 

To export data to the CSV format, select CSV... from the Export submenu. 

For the CSV format there is only a single tab shown that allows you to choose whether to 
export tasks, relationships, or both. 

Just as with MPX and Microsoft Project XML exporting, the Schedule before 
exporting option causes the project to be scheduled automatically before it is exported. 
XER 

The XER format exports most of the data your schedule contains. You can enter a new 
project name or keep the name you have as well as a short WBS (Work Breakdown 
Structure) name. 

You can opt to use your current activity code and organization for generating a WBS 
hierarchy or choose to not have a WBS structure at all. 

SDEF 

The SDEF (Standard Data Exchange Format) can be used to generate SDEF files. The SDEF 
file format does not have rigid requirements for some fields so Phoenix provides a variety of 
options to make sure your exported SDEF file will work with your other applications. 

SDEF requires several fields: 

• Project name: You can customize it to be different than the name you've given your 
Phoenix project. Can be up to forty eight characters long. 

• Project identifier: A short code to identify your project easily. Can be up to four 
characters long. 

• Contract number: Your contract number. Can be up to six characters long. 
• Contractor name: Your contractor name. Can be up to thirty six characters long. 
You can optionally map the assignment of Activity Codes in your project to various activity 
fields native to the SDEF format. To map these simply select the SDEF field from the 
dropdown and the Activity Code from the dropdown, then click Add. Warnings will be shown 
if the activity codes you are mapping have assignments that do not fit the format 
restrictions of the SDEF fields you are mapping them to. These warnings are purely for your 
information. You can still export if warnings are shown. 



The mappable SDEF fields are: 

• Workers per day: Maximum length of three numeric characters. Non-numeric code 
assignments will use "0" for this field. 

• Responsibility Code: Maximum length of four characters. 
• Work Area Code: Maximum length of four characters. 
• Mod/Claim Code: Maximum length of six characters. 
• Bid Item Code: Maximum length of six characters. 
• Phase of Work Code: Maximum length of two characters. 
• Category of Work Code: Maximum length of one character. 
• Feature of Work: Maximum length of thirty characters. 

You can toggle several compatibility options at the bottom of the dialog. Whether to activate 
or deactivate these options depends on the compliance your SDEF file requires for 
interoperability: 

• Allow holiday dates without year: If year-less holiday dates are allowed the non-
work definitions in your Phoenix project will only have to be listed once in the SDEF 
holiday list rather than being listed for every year throughout the duration of your 
project. This also means that previous and future holidays that fall outside the current 
time frame of the project are supported. 

• Allow alphanumeric calendar codes Allowing alphanumeric calendar codes allows 
you to export more than ten calendars (up to 36). 

• Allow alphanumeric activity ids Allowing alphanumeric activity ids lets you export 
with the full activity ids you use in Phoenix (but still limited to the maximum length 
defined in the SDEF specification). If you do not use alphabetic characters in your 
Phoenix activity ids this option does not concern you. 

• Allow negative relationship lag If you do not allow negative relationship lag the 
value "0" will be used whenever a negative lag occurs. Disallowing this can affect dates 
scheduled by a third party tool. 

• Allow extended constraint types Allows you to properly export Finish-No-Earlier, 
Must-Start-On, Must-Finish-On, and Start-No-Later constraints. No constraint is 
exported for these types if this option is not enabled. Disallowing this can affect dates 
scheduled by a third party tool. 

 

Raw Relationships 

The Raw Relationships export option can be found on the Export submenu of 
the Tools menu. This format exports only the relationships in a simple columnar CSV 
format. This can be much easier for some software (such as Primavera) to handle than the 
relationship format in the CSV exporter. This writes one relationship per line with each 
relationship being composed of 4 fields: Activity ID, Successor, Lag, and Relationship Type. 

 
Back to Contents 



Storepoints 
The storepoint system is useful for tracking and comparing revisions of a schedule by taking 
a snapshot of the project at a particular point in time (often done before updating a 
schedule's progress). Every schedule has at least one storepoint to hold the activity data. 
These storepoints can then be used for generating comparisons. Storepoints are often given 
names such as "Preliminary", "Baseline", or "Update 1" but any name can be given. 

The storepoint that can be edited is called the Active Storepoint. Which storepoint is the 
Active Storepoint is specific to the layout you are currently on. Each layout can have a 
different Active Storepoint specified but only one storepoint can be marked as active at a 
time for each layout. You can quickly see which storepoint is active by looking at the second 
status bar section from the left. 

 

 

 
By default a layout is set up to track the newest storepoint. This saves you the trouble of 
having to manually change the active storepoint for every layout when you create a new 
storepoint. If you'd like to lock a layout's active storepoint to a particular storepoint you can 
change that option in the Manage Storepoint window described below. 

 

Creating a Storepoint 

A storepoint can be created when you Begin 
Update... from theSchedule menu. Simple 
check the box in the Begin Update dialog 
and give the new storepoint a name. The new 
storepoint will become the Active 
Storepoint. The storepoint you were on will 
act as a snapshot of the schedule before the 
update began which can be used for future 
comparisons against other storepoints you 
have created or will create in the future. 
You can also create a storepoint without 
beginning an update to the schedule by 
selecting Create Storepoint... from 



the Schedulemenu (this can also be accessed from the Manage Storepointsdialog). This 
will open up a dialog asking you for a name and whether you want to base the new 
storepoint off of an existing storepoint or create a new blank storepoint with no data. As 
with the Begin Update storepoint creation method, the recently created storepoint will 
become the Active Storepoint. 

 

Manage Storepoints 

Storepoint management can 
be accessed from Manage 
Storepoints... in 
the Schedule menu. From 
here you can create, delete, 
rename, select the active, and 
import storepoints. 
 
The Always make the 
newest storepoint the 
active storepoint for this 
layout checkbox keeps the 
newest storepoint as the 
active storepoint for the 
current layout. This helps you 
keep layouts pointed at the 
storepoint that is likely of the 

most interest. Unchecking this lets you change the active storepoint for this layout to 
whichever storepoint you'd like. When this option is enabled and you create a new 
storepoint the active storepoint for this layout will be changed to the new storepoint. 
Otherwise the active storepoint is locked on the storepoint you have set using the Make 
Activebutton. 
Clicking the Create button works the same way as the Create Storepoint dialog described 
above. 
The Delete button will delete the selected storepoint. This can not be undone and all 
activity data for that storepoint will be lost if you save your file so be sure you want to do 
this. If the active storepoint is deleted the newest remaining storepoint is made into the 
active storepoint. 
Selecting Rename will begin editing the name of the selected storepoint. There are no 
restrictions on what you name your storepoint so be as descriptive as you want. You can 
have storepoints with identical names but this is not advised as it can lead to confusion. 
Make Active is only enabled if Always make the newest storepoint the active 
storepoint for this layout is unchecked. This button switches the active storepoint to the 
selected storepoint. Do this if you need to make changes to a storepoint. 
Import lets you insert storepoints from another Phoenix schedule file into this schedule. 
This can be useful when multiple people are working on a schedule independently. 
Back to Contents 



Comparisons 
Comparisons in 
Phoenix allow you 
to easily view 
previously created 
storepoints side-
by-side with the 
current schedule 
revision of your 
project. Click 
on Compare 
Storepoints... in 
the Schedule me
nu to open 
the Comparisons
 dialog. 
Clicking the 
dropdown box at 
the top of the 
dialog will show 
you a list of available storepoints that you can use for comparison. To compare the current 
version of the schedule with a previously created storepoint, select the desired storepoint 
from the dropdown box and then click the Add button. The storepoint you selected will 
appear in the list of comparisons. 

There are several pieces of information shown for each version used in the comparison: 

• Active: The main storepoint that the other storepoints will be 
compared against. This is your Active Storepoint and is required. 

• Color: This is the color that all schedule elements for this version will 
have. You can change this to make the comparison more readable. 
The active comparison will always be set to the current Bar 
Activity color. You can change the appearance of comparison bars and 
endpoints further in the Format Bars window. 

• Display Name: This is the name that will be shown in the Activity List 
when the Storepoint column is shown. By default it will be named the 
same as the storepoint. You can change this to be more descriptive if 
you would like. 

• Storepoint: The storepoint being compared. 
Using the Move Up and Move Down buttons you can change the order in which the 
versions are shown for the comparison. 
Clicking Remove will remove the selected storepoint from the list. 

 



 
 
These comparisons are only visible when you are using the Barchart View. After you have 
created a comparison, you will see the activities stacked with each of the compared 
schedule revisions in the same order as configured in the Comparisons dialog. When you 
select an activity, you will notice that both the current version and the compared revisions 
are selected. If you show the Storepoint column in the Activity List, you will also see the 
Display Name for each compared storepoint. 
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CPM Checker 

The CPM Checker is a unique and powerful tool. It helps you to make sure that your 
schedule makes sense, is easy to maintain, and does not violate the Critical Path Method. 

Settings 

Click CPM Checker Settings on the Tools menu to 
change the settings and bounds for the CPM 
Checker: 

• Maximum Open Starts: The maximum number 
of activities allowed to have no predecessors. Too 
many start points in your schedule can make it 
difficult to calculate float and can skew the critical 
path. 

• Maximum Open Finishes: The maximum 
number of activities allowed to have no 
successors. 

• Excessive Free Float: The maximum amount of 
free float activities are allowed to have. 

• Excessive Total Float: The maximum amount of 
total float allowed. 

• Excessive Duration: Single activities should not 
last longer than this in the schedule. If so, 
perhaps the activity should be broken up to show 
more detail. 

• Excessive Lag: The maximum lag allowed. 
• Maximum Constraints: The maximum number of constraints allowed in the schedule. 

Constraints can lead to ineffective and difficult schedules if there are too many of them 
and should be kept to a minimum. 

• Minimum Percent Critical: No less than this percentage of the schedule should have 
activities that are part of the critical path. 

• Maximum Percent Critical: No more than this percentage of the schedule should be 
critical. If there are too many critical activities, it can be difficult to identify the true 
critical path in the schedule. 

The values you use in the CPM Checker settings determine how the CPM Checker looks at 
your schedule. If any activities or relationships violate the bounds set in the CPM Checker 
settings, a balloon note will be shown pointing to the violating activity. If the percentage of 
critical activities is greater than the Maximum Percent Critical setting, you will get a 
message box informing you of the problem when you start the CPM Checker. 

Running the CPM Checker 



To start the CPM Checker, 
click Run CPM Checker on 
the Tools menu. If too much of 
the schedule is critical, there 
will be a dialog box informing 
you of this when you start the 
CPM Checker. Once started, 
the CPM Checker goes through 
each of the various checks 
showing you a balloon note 
about any CPM problems that 
are found. On a balloon note 
there is a title describing the 
type of problem found and a more detailed description explaining what the problem is and 
what needs to be done about it. 

There are several buttons on the balloon notes 

• Recheck: Restarts the CPM Checker from the beginning. 
• Explain: Allows you to explain the reasoning for certain items such as constraints, 

excessive free float, excessive total float, excessive duration, and excessive lag. 
• Skip: Skips this CPM problem until the next time the CPM Checker is run. 
• Stop: Stops the CPM Checker. 
Note: You can stop the CPM Checker at any time by clicking Stop CPM Checker on 
the Tools menu. 
Reviewing CPM Explanations 

After you have run the CPM Checker, you can review the explanations you provided while 
running the CPM Checker. To review them, just click Review CPM Explanations on 
the Tools menu. The Review Explanations dialog will allow you to view and edit the 
explanations. You can delete an explanation by checking the Delete this 
Explanation checkbox and subsequently clicking OK. By clicking Previous and Next you 
can navigate through the explanations. You can save any changes to the explanations that 
you have made by clicking OK. If you click Cancel, none of your changes will be saved. 
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Setting up Resources 
The Resource Library allows you to define various types of resources that can be assigned to 
activities in your schedule. The Resource Library window can be accessed by 
selecting Resource Library from the Info menu. 

 

Adding Resources 
A new resource can be created by clicking 
the Add button in the Resource Library. From 
here you can define the attributes of your new 
resource which include: 

• Name: This is what your new resource will be 
referred to as throughout your Project. Your 
resource's name must be unique within the 
Resource Library. 

• Type: Your resource may be one of three 
types. Labor is used for manpower (e.g., 
landscaping crew or foreman). Non-Labor is 
used for equipment such as a crane or an 
excavator. The Material type would be used 
for resources like cubic yards of concrete or 
piles to be driven. 

• Unit Label: If you would like to change the 
units in which quantities of the resource are 
shown you may specify a customized unit label. 
For instance, you may want your resource for 
flooring tiles represented in "square feet". 

• Maximum: This is the maximum concurrent allocation your new resource may have on 
a single day of work before the resource is considered Over Allocated. This can be 
useful for identifying when overlapping activities that share a resource would exceed 
the actual quantity that is available for work or usage. For example, if you have five 
carpenters on a job site and two tasks with three carpenters required for each you may 
specify five for the maximum. If the two tasks overlap you can quickly identify the 
period of time during which you have committed more carpenters than you have 
available and adjust the schedule accordingly. See the Resource Utilization Graph help 
for more information on how this is accomplished. 

• Billing Method: Whether the billing rate is applied Hourly or Daily. 



• Hours Per Day: If the Billing Method is Hourly you must specify how many hours 
per day to bill for. 

• Rate: The monetary rate for each day of use. 
• Cost Per Use: The base level bill for each usage of this resource. 

A valid value is required for all attributes in order to create the resource. 

Managing Resources 
• Sorting: The resources in the library may be sorted by any attribute by clicking on the 

corresponding column header. This ordering does not affect resource behavior and is 
available so you may more easily examine the resources available to your project. 

• Delete: A resource may be deleted by selecting it and clicking the Delete button. All 
resource allocations will also be deleted. Multiple resources can be deleted in one action 
by selecting more than one resource using the Ctrl or Select keys on the keyboard 
during selection. 

• Edit: A resource can be modified by clicking the Edit button. A dialog similar to the 
Add Resource dialog will appear. See the Adding Resources above for a description of 
resource attributes. 

Changes you make are not applied until you click the OK button. If you want to not apply 
the changes you have made click Cancel and any modifications made since you opened the 
dialog will be discarded. 
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Changes 
April 25, 2011: Version 3.0.0 

• Feature: Multiple calendars are now supported. 
• Feature: Calendars are included in copy/cut and pasting. 
• Feature: Added Early and Actual Start/Finish columns. 
• Feature: Manual Successor dialog can now select multiple successors 

and is faster. 
• Feature: Draw driving relationships as a solid line in barchart. 
• Feature: Mac and Windows users now use the same activation code 

regardless of platform. 
• Change: Improved timescale appearance. 
• Change: Greatly increased speed of drawing. 
• Change: Increased the speed of some operations. 
• Change: Improved icons, cursors, and other graphics. 
• Change: Default printing page margins are now 0.25"x0.5" 
• Change: Available storepoints are now sorted by creation date in 

Compare Storepoints dialog. 
• Change: Use Monday as the start of the week rather than Sunday. 
• Fixed: The drawing mode in Network Diagram no longer affects 

Barchart. 
• Fixed: You can no longer shrink the schedule in such a way that 

scrollbars disappear but you are scrolled off and unable to see any of 
the schedule. 

• Fixed: Node Dates now show up for Finish Milestones in Network 
Diagram. 

• Fixed: Crash that can occur when scrolling the resource graph. 
• Fixed: Resource assignments are now copied when a storepoint is 

cloned. 
• Fixed: Resource utilization graph uses the filtered activities rather than 

all activities. 
• Fixed: Feature of Work assignments from P3 are correctly handling 

duplicates during import. 

 

September 3, 2010: Version 2.1.0 
• Feature: Redesigned storepoint system. 
• Feature: Begin Update window redesigned. 
• Feature: Data date can now be placed before the current data date. 
• Feature: Manage Storepoints dialog added to add, remove, rename, 

and import storepoints from other projects. 
• Feature: The active storepoint is now listed in the status bar. 
• Feature: The active layout is now listed in the status bar. 
• Feature: The currently applied filters are now listed in the status bar. 
• Feature: Layout Manager has been redesigned to be easier to use. 
• Feature: Layouts can now be imported from other schedules. 



• Feature: Layouts can be in "Track Newest" mode where the active 
storepoint is always the newest storepoint that has been created. This 
is the default. 

• Feature: Sorting options greatly expanded and descending mode 
added. 

• Change: Use the platform standard buttons throughout the program. 
• Change: Shrunk the size of the OS X controls program wide. 
• Change: Made OS X and Windows display more consistently. 
• Change: Reorganized Columns dialog. 
• Change: Reorganized Timescale dialog. 
• Change: Reorganized Filters dialog. 
• Change: Long calendar names are now easier to see in Calendar 

Creator. 
• Change: Automatically organize network lines after importing a 

schedule. 
• Change: Ignore completed activities for the summary rollup late dates. 
• Change: Percent complete summary rollup now uses the aggregate 

duration and remaining duration to create a percentage rather than 
averaging the percent complete of each activity. 

• Change: Late dates are not shown for completed activites or for 
hammocks and flags. 

• Change: Avoid using icons in most menu items on OS X to fit into the 
native appearance of OS X better. 

• Change: Remove all bar and endpoint gradients as they cause issues 
with both OS X and Windows PDF printing. 

• Change: Layouts no longer require a separate saving step to record 
the changes made. 

• Change: Storepoints no longer use a version and revision for 
identification. 

• Fixed: OS X will now default to the current sorting method when the 
sort dialog is opened. 

• Fixed: Re-enable spellchecker on OS X. 
• Fixed: Crash when changing a date filter criteria's equality option. 
• Fixed: Milestones can be dragged vertical in Network Diagram again. 
• Fixed: Rectangle rendering was sometimes off by one on OS X. 
• Fixed: Column header text alignment now works correctly on OS X. 
• Fixed: Project Bird's Eye percent complete was inverted (giving the 

percent remaining). 
• Fixed: Remaining duration summary rollup could be off by one in 

certain cases. 
• Fixed: Allow the user to have as long of numeric activity ID as they 

wish. 
• Fixed: Use simulated transparency for progress spotlight on Windows 

PDF because the PDF printer does not properly support transparency. 
• Fixed: Crash when up key is hit at the top of the activity list. 
• Fixed: Some column headings were squished on OS X 
• Fixed: Crash when bars were reset to default while comparisons were 

being shown. 



• Fixed: Error when a resource assignment had an allocation of 0. 

 

July 6, 2010: Version 2.0.9.0 
• Feature: Added ability to map activity codes to SDEF export fields 

 

June 23, 2010: Version 2.0.8.1 
• Fixed: Require administrator privileges on Vista/Windows 7 

 

June 18, 2010: Version 2.0.8.0 
• Built with Visual Studio 2010 
• Fixed: Use the calendar with the most activities assigned to it as the 

default calendar in a P3/Suretrak import. 
• Fixed: Handle case where P3/Suretrak schedule has unused calendar 

slots or calendars with no names in P3/Suretrak imports. 

 

May 27, 2010: Version 2.0.7.1 
• Fixed: SDEF unit costs should always use daily allocation 

 

May 25, 2010: Version 2.0.7.0 
• Feature: SDEF export support (Pro only) 
• Fixed: Avoid using scientific notation for very large or very small 

values in the resource graph and resource assignment window. 
• Fixed: Either network diagram or barchart (whichever wasn't visible) 

wouldn't reorganize itself when the currently selected layout changed. 

 

May 17, 2010: Version 2.0.6.0 
• Fixed: Billed in the activity editor could fall out of sync. 

 

April 28, 2010: Version 2.0.5.1 
• Fixed: Barchart/Columns split and resource graph split could fall out of 

sync. 

 

April 22, 2010: Version 2.0.5.0 
• Upgrade: Upgraded PDF printer on Windows to add Windows 7 64-bit 

support. 
• Change: Default calendars are not added to P3/Suretrak imports. 



• Fixed: Potential application freeze while importing from P3/Suretrak. 
• Fixed: Project finish is calculated if the value isn't available from 

P3/Suretrak. 

 

April 20, 2010: Version 2.0.4.0 
• Feature: P3 WBS is now imported as Activity Codes 
• Change: Toggled toolbar tools now look better on OS X. 
• Fixed: OS X Font dialog could cause crash. 
• Fixed: Resource library would not reflect changes made to a newly 

created resource. 
• Fixed: MPX/MSXML could import with invalid relationship types for 

milestones. 
• Fixed: MSXML resource parsing could lead to a format error that 

prevented importing. 

 

March 26, 2010: Version 2.0.3.1 
• Change: OS X no longer uses gradient bars due to a printing bug in OS 

X. 
• Change: No more assertions for OS X builds. 
• Fixed: MSXML calendar exceptions are now imported accurately. 

 

March 24, 2010: Version 2.0.3.0 
• Change: P3 import defaults to Status on Current scheduling method 

now. 
• Fixed: MPX importing now works as it should on OS X. 
• Fixed: MSXML export would sometimes have durations tripled due to 

24 hour workdays rather than the usual 8 hour. 
• Fixed: MSXML import status date could sometimes load incorrectly 

leading to errors in the schedule. 
• Fixed: Import dialog looks better on OS X. 

 

March 19, 2010: Version 2.0.2.0 
• Change: Changing format options now marks the project as modified. 
• Fixed: Date formatting is now properly saved. 

 

March 17, 2010: Version 2.0.1.0 
• Feature: Importing from Suretrak officially supported. 

 

March 10, 2010: Version 2.0.0.4 



• Feature: Update On Schedule dialog contains more options for picking 
a new data date. 

• Fixed: Update On Schedule now applies partial progress to activities 
that intersect with the data date. 

• Fixed: Vertical scrolling with the mouse wheel is now supported. 
• Fixed: Implemented method of pushing a holiday which falls on a 

weekend out to the next non-weekend day while importing non-work 
definitions from P3. 

 

March 3, 2010: Version 2.0.0.2 
• Fixed: Greater than 1 day ranged non-work calendar definitions are 

now imported accurately from P3. 
• Fixed: Unhandled exception error when an invalid date is entered into 

the Calendar Creator. 
• Fixed: Overlapping non-work definitions won't be counted twice during 

duration calculations. 
• Fixed: Repeated day of month non-work definition is now more 

accurate. 
• Fixed: Find Activity for finish dates now works properly. 

 

February 12, 2010: Version 2.0.0.0 
• Feature: New sample schedules added. 
• Feature: Added several new constraint types making it possible to 

constrain activities to "Finish No Earlier Than", "Finish No Later Than", 
"Must Start On", "Must Finish On", "Start No Earlier Than", and "Start 
No Later Than". 

• Feature: Added a new Resource Library for adding, removing, and 
changing assignable labor, non-labor, and material resources. (Pro 
Only) 

• Feature: Added a resource assignment dockable tool window for 
changing resource assignments for any single activity. (Pro Only) 

• Feature: Added the new Resource Utilization Graph window that shows 
a time interval histogram and line chart showing the utilization of any 
single resource in either Barchart or Network Diagram views. (Pro 
Only) 

• Feature: Replaced the Report Writer with a new template-based 
reports system which now has the ability to publish reports to HTML 
files. 

• Feature: The CPM Checker report can now be run regardless of 
whether the CPM Checker has been run on a project. 

• Feature: Combined the Earned Value, Under Budget, and Over Budget 
reports all into one Cost Account report. 

• Feature: Improved appearance of default bar and relationship styles so 
driving and non-driving relationships are more clear. Old schedules can 



use these new styles by opening the Bar Format window, and clicking 
the "Reset to defaults" button. 

• Feature: Added constraint type to the available Activity List columns. 
• Feature: Improved the "Group by Codes" feature in the Network 

Diagram view to automatically collapse activities on to the same line 
where it makes sense. 

• Feature: Added XER import and export (with the ability to use Activity 
Codes as the WBS structure, and vice versa). 

• Feature: The trial version of Phoenix can now be directly activated into 
the full Express or Professional version without the need to uninstall 
and reinstall Phoenix Project Manager on Windows (Mac already does 
this). 

• Feature: Criticality can now be defined by whether or not the activity is 
on the longest path instead of just checking for low total float. 

• Fixed: Redesigned the Project Info dialog for better usability. 
• Fixed: Activities with original durations that are inconsistent with start 

and finish dates are now automatically repaired on load. 
• Fixed: Multiple selection is now correctly disabled in the Code Library. 
• Fixed: Global formatting of monetary values now also supports 

negative values. 
• Fixed: Calculations of estimated remaining cost in reports now takes 

activity progress and budget into account instead of billed amounts. 
• Fixed: Custom mouse cursors set inside of the Activity List header or 

the Timescale are now correctly reset on Mac OS X. 
• Fixed: Repeating non-works are no longer given explicit expiration 

dates. 
• Fixed: Moved the determination of driving relationships to the 

backwards scheduling pass, where more than one driving relationship 
per successor can be identified and marked. 

• Fixed: Auto-numbered activities are now pasted in the same order 
they were in when they were copied. 

• Fixed: Phoenix now makes it impossible to set every weekday as a 
non-work, which would only result in a project that would never finish. 

 

March 9, 2009: Version 1.4.0.18 
• First Mac OS X version of Phoenix Project Manager released. 
• Feature: Budget and Billed information can now be added to bars in 

Barchart view. 
• Feature: Activities can now be filtered by remaining duration and 

percent complete. 
• Feature: Billed amounts for activities now automatically update with 

changes to the activity's progress. 
• Fixed: Crash when changing Activity Code order in the Organization 

format window. 



• Fixed: Weekdays button is now appropriately disabled when no 
calendar is selected in the Calendar Creator (clicking it caused a 
crash). 

• Fixed: Activity durations no longer change from imported schedules 
that are lagged from predecessor activities (lag wasn't taken into 
account correctly). 

• Fixed: Phoenix no longer occasionally crashes with more than one 
schedule open at the time of being closed. 

• Fixed: Activity List column header titles show in the correct position 
when using vertical alignments other than Top. 

• Fixed: Activities are now auto-scheduled when constraints are changed 
and realtime scheduling is turned on. 

• Fixed: Calculation of optimum column width in the Activity List now 
appropriately takes into account multi-line column labels. 

• Fixed: Extraneous scheduling during some actions taken with the 
mouse is no longer done while realtime scheduling is turned off. 

• Fixed: Custom logo 2 in the page layout settings is now saved 
correctly rather than reverting back to the Phoenix logo. 

• Fixed: Early finishes of some unstarted activities in retained logic 
schedules with relationships before the data date are now correctly 
calculated. 

• Fixed: Lag-To now correctly calculates lags on relationships tied to the 
finish of the successor when the successor is a task. 

• Fixed: Changing a relationship to a Finish to Finish type in the 
relationship editor dialog now works. 

• Fixed: Lag-To calculates zero lag if the start date is already on the 
desired lag-to date. 

• Fixed: Crash when running an Earned Value report when there is an 
account that has a budget of zero. 

• Fixed: Project Bird's Eye report now updates with the correct values 
when the project calendar is changed from it's initial calendar, but no 
changes are made to the project. 

• Fixed: Child budget accounts now correctly transfer reported totals 
when parent budget account assignments are transferred. 

 

March 21, 2008: Version 1.4.0.9 
• Feature: New tool window docking with saved layouts, better size 

handling, and more flexible positioning. 
• Feature: All activities are now assigned to the "Total Project" cost 

account by default. This also applies to old schedules as well. 
• Feature: Relationship type options throughout Phoenix now only show 

valid types for that specific relationship rather than all types. 
• Feature: Activity Ids can now be sorted even if the number comes 

first. 
• Feature: Multiple instances of Phoenix can now be run at the same 

time. 



• Feature: Major optimizations made to scheduling projects with a 
majority of starts and finishes set as actual dates. 

• Feature: Activity Editor has been redesigned for efficient use of space 
while hiding fields not pertinent to the activity selected based on type. 
It also now gives visual feedback about any fields that are changed 
automatically. 

• Feature: New activities now use the start date of the currently selected 
activity by default making it easier to tie in for common usage. 

• Fixed: All cost account related windows have been optimized to better 
handle existing activity cost account assignments when making 
changes, and easier to understand options. 

• Fixed: Phoenix now makes a best guess on relationship type if the 
activity type is changed to one that doesn't support that relationship. 

• Fixed: Find & Replace now works correctly with Undo/Redo. 
• Fixed: Importing multiple unnamed calendars from Primavera 3.1. 
• Fixed: Copy & Paste now only copies interconnected relationships. 
• Fixed: Finish milestones and flags report the correct date when rolled 

up with an activity code. 
• Fixed: CSV export now uses "Activity ID" instead of "ID" to avoid SYLK 

related errors when opened with Microsoft Excel. 
• Fixed: Crash when opening schedules with activity codes with no 

values. 
• Fixed: Various Activity Editor inconsistencies when modifying certain 

fields that affect other activity values. Affected values are now 
highlighted during edits to show changes. 

• Fixed: Edits to activities no longer reorganize the schedule if changes 
don't require a reorganization. 

• Fixed: License deactivation when using docking stations with laptops. 
• Fixed: Crash while opening the Comparison window on computers 

using the Windows classic theme. 
• Fixed: Paste activity Id remapping no longer hangs in certain modes. 
• Fixed: Cost account totals are now automatically recalculated when 

shown in the Cost Accounts window as well as related reports. 
• Fixed: Activity codes present before an activity paste are no longer 

removed upon undoing that paste when "Apply Activity Codes" is used. 
• Fixed: The activity code tool window is now updated with any activity 

code changes after pasting activities with new codes. 
• Fixed: Budget and billed amounts can now be reset back to $0.00. 
• Fixed: Required requests for Administrator access on Windows Vista 

are now made for users with User Account Control (UAC) turned on. 

 

December 3, 2007: Version 1.3.0.12 
• Feature: Activation system now uses port 80 for better support within 

corporate firewalls. 
• Feature: Major optimizations made to loading saved schedules. 
• Fixed: Corrected newline output with CSV export. 



• Fixed: Corrected printout date ranges with non-works shown. 
• Fixed: Corrected tab navigation order in the Activity Editor. 
• Fixed: Successor relationship scheduling on activities with mandatory 

constraints. 
• Fixed: Disabled constraint options depending on last selected activity. 
• Fixed: Disappearing rollup bars are now shown appropriately. 
• Fixed: Various CPM Checker visual improvements with custom themes. 
• Fixed: Changes to calendars not being saved. 
• Fixed: Hammocks now use the latest finish date instead of earliest. 
• Fixed: Major user interface improvements when editing relationships. 
• Fixed: Free float is now saved so scheduling isn't required when 

loading an existing schedule. 
• Fixed: Late Start/Finish incorrectly reported dates based on free float 

in the Activity List instead of calculating from total float. 
• Fixed: CSV import now calculates duration from start and finish dates 

if not given in any columns. 

 

May 23, 2007: Version 1.3.0.5 
• Feature: Checkboxes added to the Activity Code tool window for 

quickly showing or hiding activity codes. 
• Feature: Exporting raw relationship data in CSV format. 
• Feature: Show/Hide all non-driving relationships. 
• Feature: Importing from comma delimited files (CSV). 
• Feature: Exporting to Microsoft Project Exchange (MPX) format. 
• Feature: Exporting to Microsoft Project XML format. 
• Feature: Exporting to comma delimited file (CSV). 
• Feature: Built-in printing to PDF files. 
• Feature: Toggling node dates for all selected activities. 
• Fixed: Printer page size selections from page setup other than "Letter" 

are correctly applied to printouts no longer requiring that page sizes 
are selected just before printing. 

• Fixed: Ability to add relationships in the predecessor and successor 
tool windows to Milestone activities. 

• Fixed: Major speed improvements when scheduling comparisons in 
some schedules that triggered abnormally long scheduling times. 

• Fixed: Comparisons other than the key comparison are now 
rescheduled using the currently selected scheduling method. 

• Fixed: Activity Code tool window is now updated to reflect selected 
activities when selecting activity code headings in Network Diagram 
view. 

• Fixed: Various minor font size calculations when printing or previewing 
Barchart and Network Diagram printouts. 

• Fixed: Irrelevant milestone and flag dates are no longer shown in the 
Predecessor and Successor tool windows. 

• Fixed: Changing milestones or flags back to simple activities. 



• Fixed: Various issues with deleting layouts along with some additional 
improvements managing layouts. 

• Fixed: Correct activity code value assignments are now applied when 
pasting activities (a bug introduced in the last update). 

• Fixed: Activity code organization is now applied properly when 
importing from Primavera 3.1 without rescheduling. 

• Fixed: Changing activity Ids no longer loses assigned activity code 
values. 

• Fixed: Undoing activity deletion no longer loses relationships tied to 
those activities. 

• Fixed: Undo/Redo Activity Code Library changes adding redundant 
codes and values. 

• Fixed: Begin Update now works correctly with Undo/Redo. 
• Fixed: Moving start date when printing multiple copies from print 

preview without closing preview. 
• Fixed: Bug with inserting text and images in Network Diagram view 

after deleting any existing text or image. 
• Fixed: Crash involved with copying and pasting activities from 

schedules with different calendars. 
• Fixed: Made some major optimizations with creating relationships 

visually in large schedules (both Barchart and Network Diagram). 
• Fixed: More optimizations with organizing by Activity Codes in the 

Barchart view (this should be noticable with most schedule changes 
while in Barchart view). 

• Fixed: Importing of relationships from MPX and XML projects. 
• Fixed: Filter Show/Hide settings are now saved with the layout. 
• Fixed: Renaming activity code values now correctly applies to activities 

assigned to those values. 
• Fixed: Ability to undo activity code changes made using Fill Cell. 

 

November 14, 2006: Version 1.2.0.5 
• Feature: Activity Ids can now be changed (in new and old schedules). 
• Feature: Scaling Barchart and Network Diagram printouts. 
• Feature: New Report Writer dialog with UI improvements, report 

descriptions, and total page count. 
• Feature: Cleaner, more appropriate, identifiable icons. 
• Feature: Activity Code rollup in Barchart view. 
• Feature: Additional timescale tier for displaying weeks. 
• Feature: Preset common activity codes for new projects. 
• Feature: Importing directly from Primavera 3.1. 
• Feature: New Columns Format dialog with ability to configure column 

label text alignment. 
• Feature: Easier to use, and more informative CPM Explanation creation 

and review process. 



• Feature: Window scroll positions, zoom levels, and timescale sizes are 
now saved per layout as well as kept track of separately between 
Barchart and Network Diagram views. 

• Feature: New Barchart comparison column type. 
• Feature: New Comparisons configuration dialog, allows for Activity List 

labels, and key comparison on lines other than the first. 
• Feature: Project files are compressed automatically when saved. 
• Feature: Print layout logos are now saved in the project file. 
• Feature: New, simplified activity editor configuration dialog. 
• Feature: Ability to show individual activity node dates in the Network 

Diagram (right-click on nodes for options). 
• Feature: Images can now be added anywhere in the Network Diagram, 

scaled as needed, and are saved in the project file. 
• Feature: Scroll position in both Barchart and Network Diagram modes 

can be changed by holding middle-click and dragging. 
• Fixed: New filters configuration dialog with fixes for a couple filter and 

criteria ordering and deletion issues. 
• Fixed: Setting custom printout page margins. 
• Fixed: Using Fill Cell on the cost-to-date (billed) column. 
• Fixed: Minor copy and paste issues. 
• Fixed: Unintentional activity creation when deleting the last activity in 

Barchart view. 
• Fixed: Various Windows 98 incompatibility issues. 
• Fixed: Horizontal scrolling of the Activity List. 
• Fixed: Network text labels incorrectly drawn in Barchart view. 
• Fixed: Invalid mouse position calculations while scrolled horizontally in 

the Activity List. 
• Fixed: Shift selection in Barchart view. 
• Fixed: Interactive CPM Checker mode initialization. 
• Fixed: Network Diagram text labels now scale properly with zoom. 
• Fixed: Cleaned Network text label selection outline remnants while in 

other Network modes and in printouts. 
• Fixed: Various issues with cancelling updates with new activities. 
• Fixed: More Network Diagram mode distinction with various actions. 
• Fixed: Activity List initialization for CPM Checker in Barchart. 
• Fixed: Network mode selection shows correctly when switching 

between other open projects in different modes. 
• Fixed: Disabled Network mode selection when in Barchart view. 
• Fixed: Incorrect float calculations when using hammocks. 
• Other: Activity code changes now apply instantly (no enter needed). 

 

March 7, 2006: 1.0.0.27 Release, 1.0.0.65 Demo Release 
• Feature: New updated, easier to browse User Manual. 
• Feature: New sample project demonstrating additional features. 
• Fixed: Printing schedules with an arbitrary range start date. 
• Fixed: Calculation of constrained finish milestone dates. 



• Fixed: Unrelated, unconstrained 0-day duration activity calculations 
(milestones, flags, etc). 

• Fixed: Various printout logo fixes (alpha, userscale/image resolution, 
additional file format support, and saved file locations). 

• Fixed: Deleting text in controls with the Delete key. 
• Fixed: Various font size calculations (GetTextExtent). 
• Fixed: Network bounding box label mouse region sizes. 
• Fixed: Finished activities being reported as 0% complete. 
• Fixed: Activity code organization configuration crash. 
• Fixed: Made changing year in date selection controls easier. 
• Fixed: Sorting activities by activity Id. 
• Fixed: Barchart splitter is now restricted to the size of the Activity List. 
• Fixed: Various Undo/Redo crashes due to quick repeated use. 
• Fixed: Scrolling/Autoscroll performance and time rate limiting. 
• Fixed: Format Columns window crash. 
• Fixed: Timescale no longer makes the change permanent when turning 

off all tiers in the Format Timescale window. 
• Fixed: Missing scrollbars in specific situations. 
• Fixed: Layout switching bug causing Network/Barchart view confusion. 
• Fixed: Various features no longer include filtered activities (Find 

Activity, Find/Replace, Select All). 
• Fixed: Disabled setting the project start date on a non-work day. 
• Fixed: Corrected reported finish date type in the Activity List. 
• Fixed: Numerous Activity Editor control settings with regard to the 

selected Activity Type. 
• Fixed: Disabled setting the proposed Data Date to a date before the 

current Data Date when updating. 
• Fixed: Activity List data entry bug when setting same values. 
• Fixed: Critical Activity report now takes the critical threshold setting 

into account. 
• Fixed: Various bugs using Activity Code column types in Barchart. 
• Fixed: Numerous additional column types now support Fill Cell. 
• Fixed: Fill Cell is no longer added to Undo/Redo when nothing has 

changed (for columns that don't support Fill Cell). 

 

November 11, 2005: 1.0 Demo CD Release 
• Feature: Added Activity Type support to Fill Cell. 
• Fixed: "Sort By" settings are now saved in layouts. 
• Fixed: Warns to save after page layout settings are changed. 
• Fixed: Previously saved page layout settings are loaded with layout. 
• Fixed: Miscellaneous window refresh fixes with auto-scrolling. 
• Fixed: Constraints take Daylight Savings Time into account. 

 

September 21, 2005: 1.0 Initial Release 
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